# Table of Contents

## Chapter 1: Text

Major Sections of a Document.................................................................6
Multi-Chapter Documents.....................................................................6
Single-Chapter Documents .................................................................8
Style, Paragraph, and Font Issues..........................................................9
Word Usage..........................................................................................14
Words Not Capitalized..........................................................................21
Indexing Guidelines...........................................................................26
For More Information...........................................................................30

## Chapter 2: Documentation Artwork

Overview..............................................................................................32
Screenshots.........................................................................................32
Graphics..............................................................................................33
Taking Your Screenshots......................................................................35
Capturing the Dashboard .....................................................................35
Context Screenshots..........................................................................35
Example.............................................................................................36
Detail Screenshots.............................................................................37
Examples.............................................................................................37
Capturing the Workbench.................................................................39
Context Screenshots..........................................................................39
Example.............................................................................................40
Detail Screenshots of Workbench Windows.......................................40
Detail Screenshots of Workbench Windoids .......................................41
Examples.............................................................................................42
Visio Tips and Tricks...........................................................................44
Table of Contents

Working with Artwork in FrameMaker ................................................................. 47
  Importing Your Artwork .................................................................................. 48
  Annotating Your Screenshots ....................................................................... 51
  Verifying the Formatting .............................................................................. 52

Chapter 3: Process .......................................................................................... 53
  Product Development Process ....................................................................... 54
  Document Authoring Process ....................................................................... 55
  Document Review Process ............................................................................ 56
  Document Editing Process ............................................................................ 57
    Developmental Edits .................................................................................. 57
    Copy Edits ................................................................................................ 57
  Review/Production Checklist ........................................................................ 58

Chapter 4: Release 6.0 Production Procedure for Authors ............................. 61
  Prerequisites .................................................................................................. 62
    Requirements .............................................................................................. 62
    Highly Desired ........................................................................................... 63
    Requested .................................................................................................. 63
  Getting Your Document Into a Build ............................................................. 64
  Assessing the Evaluation Site Results ............................................................ 64
    For the HTML Version of Your Document ............................................... 64
    For the PDF Version of Your Document .................................................. 65
  Assessing the Product Results ..................................................................... 66

Appendix A: Importing Excel Data ................................................................. 67

Index .............................................................................................................. 71
In This Chapter:

- Major Sections of a Document
  - Multi-Chapter Documents
  - Single-Chapter Documents
- Style, Paragraph, and Font Issues
- Word Usage
- Words Not Capitalized
- Indexing Guidelines
- For More Information
Major Sections of a Document

There are multi-chapter and single-chapter documents in Mercury IT Governance Center documents release 6.0.

Multi-Chapter Documents

Multi-chapter books contain the following sections, which are described in detail in the FrameMaker template guide:

- Title page

  The title pages of all books with product names in them should have the word “Mercury” in front of the product name.

  The product names should have a TM symbol associated with them on the title page. This is in addition to the TM on first mention in the body of the text.

- Copyright page

- Table of contents

- List of figures

- List of tables

- Introduction chapter, which contains the following sections:
  
  - About This Document
  
  - Who Should Read This Document
  
  - Prerequisite Documents
  
  - Related Documents
  
  - Overview of [topic] or overview of the [topic]

    Use an overview section here and throughout the book where needed to provide relevant high-level background information.

    Do not use [topic] Overview.

  
  - For More Information
Use in this chapter and throughout the book for cross-references to other sections of this document and to reference other documents. Use the H5 (Simulated) paragraph tag to separate the references from surrounding text.

Begin with “For more information about [topic] see [reference].”

If this section relates to an entire chapter, include it as an H1 section (with similar treatment for sections below the chapter level).

- **Other chapters**

  Chapters should contain concept and task information, with only a small amount of reference information.

  In general, chapters presented throughout the document or topics within a given chapter should flow:

  - In time sequence (for example, put tasks users will tend to do first ahead of tasks they will tend to do later)
  - In a sequence that proceeds from easy to difficult
  - In a sequence that proceeds from common to rare
  - In a sequence that proceeds from important to less important

- **Appendixes (if required)**

  Appendixes should contain either reference information or information used seldom or by only a small subset of users.

  Appendixes in a given document would typically have little or no relationship to one another. Appendixes should flow:

  - In a sequence that proceeds from common to rare
  - In a sequence that proceeds from important to less important

- **Index**

  Every document should have an index.

  The indexes in documents appearing in HTML format are merged by the WebWorks process. Therefore, writers of those documents need to be sure their indexes merge gracefully.
For general indexing guidelines, see *Indexing Guidelines* on page 26.

**Single-Chapter Documents**

Single-chapter documents include *Release Notes* and possible white papers. They use a special single-chapter FrameMaker template.
# Style, Paragraph, and Font Issues

Table 1-1 lists common style, paragraph, and font issues.

### Table 1-1. Style, paragraph, and font issues (page 1 of 5)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>acronym</td>
<td>- Spell out at first use (except common ones like SQL).</td>
</tr>
<tr>
<td></td>
<td>- an SQL statement</td>
</tr>
<tr>
<td>active voice</td>
<td>In general, favor active over passive voice.</td>
</tr>
<tr>
<td>address (Web)</td>
<td>- No bold, italic, or underline.</td>
</tr>
<tr>
<td></td>
<td>- No http:// except where you need to differentiate between https and http.</td>
</tr>
<tr>
<td></td>
<td>- Use only lowercase.</td>
</tr>
<tr>
<td>bullet</td>
<td>- Begin each bulleted item with an initial cap.</td>
</tr>
<tr>
<td></td>
<td>- If bullets are complete sentences (in and of themselves), end with a period.</td>
</tr>
<tr>
<td></td>
<td>- If bullets are incomplete sentences, don’t end with a period.</td>
</tr>
<tr>
<td></td>
<td>- Alternate Bullet and BulletHollow for multi-level entries.</td>
</tr>
<tr>
<td></td>
<td>- The top-level entry should always be Bullet or Step — never BulletHollow.</td>
</tr>
<tr>
<td></td>
<td>- Bulleted items followed immediately by text should be bold and followed by a period.</td>
</tr>
<tr>
<td>button</td>
<td>- For example, <strong>Submit</strong> button. Use the Button/Menu/Tab font style.</td>
</tr>
<tr>
<td></td>
<td>- Use the term on first mention for clarification; you don’t need to use <em>button</em> thereafter. For example, “At the top of the menu bar is the <strong>Expand All</strong> button. Clicking <strong>Expand All</strong> displays all submenus . . .”</td>
</tr>
<tr>
<td></td>
<td>- You don’t need to use <em>button</em> if the context is clear; for example, “Click <em>Done.</em>”</td>
</tr>
<tr>
<td>callout</td>
<td>- Cross-reference located in the text preceding a figure or table that introduces it. See figure title.</td>
</tr>
<tr>
<td></td>
<td>- Label identifying elements in a figure. See figure label.</td>
</tr>
</tbody>
</table>
## Table 1-1. Style, paragraph, and font issues (page 2 of 5)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
</table>
| capitalization    | • Use standard heading capitalization for headings (that is, capitalize every word, with a few exceptions)  
|                   | • Capitalize the second word in a hyphenated term (for example, “Single Sign-On”)  
|                   | • Do not capitalize file names in headings (for example, server.conf file)  
|                   | • Capitalize pronouns in headings (for example, Its)  
|                   | • Use sentence-style capitalization for figure and table titles  
|                   | • Do not capitalize file names in figure and table titles, even if they are the first word  
|                   | • Capitalize entity names but not entity types for Mercury IT Governance Center entities. For example, “Workflow Detail report”                                                                 |
| Caution box       | Do not use; use a Warning box.                                                                                                                                                                         |
| code paragraph style | Insert a blank line before one or more lines of code.                                                                                                                                             |
| continuation variable | • Put a continuation variable in the title of every table, regardless of whether or not it requires one at the time it gets created.  
|                   | • If the table grows to more than two pages, use the “page x of y” style.                                                                                                                          |
| Courier           | Use this font for command and file names. (the Code font in the font catalog.)                                                                                                                        |
| Definition box    | Do not use; use a Note box.                                                                                                                                                                          |
| em-dash           | Close on either side.  
|                   | For example, “This is a new feature—added in release 6.0.”                                                                                                                                           |
| en-dash           | Close on either side.  
|                   | <<Needs an example.>>                                                                                                                                                                               |
| Example box       | Do not use; use either Note or a longer example starting with an H5 (Simulated) titled *Example*.                                                                                                     |
| figure label      | <<How are we doing these? I don’t see the paragraph tag.>>                                                                                                                                            |
| figure title      | • Always include a cross-reference in the text preceding a figure. If the figure is on the same page, don’t include a page number. Page numbers for figures not on the same page are optional, unless the reference and figure are separated by several pages or more.  
|                   | • Don’t use a figure title for a figure within a procedure.                                                                                                                                          |
|                   | • Use sentence-style capitalization.                                                                                                                                                                  |
Table 1-1. Style, paragraph, and font issues (page 3 of 5)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>hyphen</td>
<td>Close on either side. For example, “The range is 1-50.”</td>
</tr>
<tr>
<td>hyphenation</td>
<td>Avoid. Never hyphenate product names.</td>
</tr>
</tbody>
</table>
| icon             | • Always use the word *icon* after the UI item you’re identifying; for example, “Click the Portlet Help icon to view help about the portlet you’re using.” Use the Button/Menu/Tab font style.  
• Example: **Environments** icon (Workbench interface).  
• Do not use this term for a button with text (use *button* instead).  
• Do not include icons in inline text. Use sparingly. If you need to show an icon, put it into an anchored frame. |
| italic           | • Use this font for book names. (Italic in the font catalog.)  
• Do not use the first time a new term appears.  
• Use for emphasis (for example, “I’m talking about the word *text*, not *test.*”)  
• Links are in blue italic. |
| Key Concepts     | • Do not include a section of this name (use Overview, instead).  
• Point to the *Key Concepts* book as a prerequisite. |
| Mercury Support  | Use the following URL: [http://support.mercury.com](http://support.mercury.com) |
| navigational sequence | • Use a single greater-than symbol (>); for example, **Create > Package**.  
• Note that the greater-than symbol is not bold. |
| note to reviewers | • Use `<note>` for notes to reviewers during the book review cycle. Be sure to remove the brackets before the book goes to production.  
• You can also use AuthNote or SMENote paragraphs |
| Note box         | • Use this and Warning box.  
• Do not use Caution, Definition, Example, or Tip boxes. |
## Chapter 1: Text

### Table 1-1. Style, paragraph, and font issues (page 4 of 5)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
</table>
| **numerals**          | • Spell out zero through nine.  
• Spell out percent in all references in text.  
• Use Q3 2004 or Q3'04.  
• In phone numbers, start with the country code. Put parentheses around the area code and dashes (hyphens) in the main number. For example, 1 (800) 343-4400. |
| **punctuation**       | • No spaces before or after hyphens (no hyphens with -ly adverbs, no hyphens with most prefixes).  
• No spaces with -en dashes (for example, 4-6 months).  
• Spaces with -em dashes (for example, word1 — word2).  
• Use serial commas before concluding conjunctions (for example, apples, bananas, and pears)  
• Use US style for quotation marks and punctuation (for example, period inside quotation marks). |
| **quotation marks**   | • Use curly quotes in text.  
• Use straight quotes only in Courier (Code) examples.  
• Don’t put common phrases in quotation marks (for example, voted best-in-class, Mercury IT Governance Center . . .). |
| **sheet x of y table continuation variable** | See continuation variable. |
| **signs and symbols** | Don’t use the ampersand symbol (&) except in proper names that have it. |
| **table title**       | • Always include a cross-reference in the text preceding a table. If the table is on the same page, don’t reference a page number. Page numbers for tables not on the same page are optional, unless the reference and figure are separated by several pages or more.  
• Don’t use a table title for a table within a procedure.  
• Use sentence-style capitalization. |
| **Tip box**           | Do not use; use Note box. |
### Table 1-1. Style, paragraph, and font issues (page 5 of 5)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>trademark</td>
<td>• Include the trademark symbol with Mercury™ at first usage.</td>
</tr>
<tr>
<td></td>
<td>• Include the trademark symbol with the “Center” or product name at first usage in a given document (for example, Mercury IT Governance Center™ or Mercury Change Management™).</td>
</tr>
<tr>
<td></td>
<td>• The only registered Mercury products are LoadRunner®, WinRunner®, TestDirector®, and SiteScope®. Include the mark at first usage.</td>
</tr>
<tr>
<td></td>
<td>• For third-party products, include the registered mark only for companies with which we have a legal commitment to do so (SAP is one of those companies).</td>
</tr>
<tr>
<td></td>
<td>• For an official product names list, with trademark information for IT Governance Center products, see the file Product-ServicesNames_Master_October_FINAL.xls in the Documentation section of sharedITG.</td>
</tr>
<tr>
<td>Warning box</td>
<td>• Use this and Note box.</td>
</tr>
<tr>
<td></td>
<td>• Do not use Caution, Definition, Example, or Tip boxes.</td>
</tr>
<tr>
<td>we (the “royal we”)</td>
<td>Do not say “We recommend that customers . . .” Instead, say “Mercury recommends that customers . . .”</td>
</tr>
<tr>
<td>widows and orphans</td>
<td>Insert manual page breaks, if necessary, to avoid bad page breaks.</td>
</tr>
<tr>
<td>word wraps, line breaks,</td>
<td>• Avoid breaking Mercury Interactive and product names.</td>
</tr>
<tr>
<td>page breaks</td>
<td>• Never hyphenate product names.</td>
</tr>
</tbody>
</table>
## Word Usage

*Table 1-2* lists common word usage issues.

### Table 1-2. Word usage (page 1 of 7)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>activate</td>
<td>Do not use. Use <em>enable</em>.</td>
</tr>
<tr>
<td>Adobe Reader</td>
<td>Use this for the product with which customers view our PDF documents. Do not use Adobe Acrobat.</td>
</tr>
<tr>
<td>appear</td>
<td>Dialog boxes <em>open</em> and <em>close</em>, not <em>appear</em> and <em>disappear</em>. Pages <em>appear</em> and <em>disappear</em>.</td>
</tr>
<tr>
<td>application</td>
<td>The key products that are part of Mercury IT Governance Center (for example, Mercury Change Management, Mercury Portfolio Management).</td>
</tr>
</tbody>
</table>
| as is, as-is          | • Adverb: as is  
                         • Adjective: as-is                                                   |
| auto-populate         | Hyphenate.                                                            |
| auto-complete         | Hyphenate.                                                            |
| bash (bash shell)     | Use this. Note capitalization.                                       |
| before                | No not use in a phrase like *Oracle 9i or before*. Use *Oracle 9i or earlier*, instead. |
| book                  | Avoid; use *document* when referring to items in our documentation set. |
| Bourne shell          | Use this. Note capitalization.                                       |
| cancelling            | Note spelling. Approved gerund. Approved spelling might change to *canceling* for the 7.0 release. |
| Caution               | Do not use as a synonym for Warning.                                  |
| check                 | Don’t use when you mean the action of clicking a checkbox to *select* an option. |
| checkbox              | Note one word.                                                       |
| check in, check-in    | • Verb: check in  
                         • Adjective: check-in                                                 |
| check out, check-out   | • Verb: check out  
                         • Adjective: check-out                                                 |
<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>child</td>
<td>Used to describe a <em>parent-child</em> relationship. Avoid elsewhere.</td>
</tr>
<tr>
<td>choose</td>
<td>Use only when documenting generic procedures — not mouse procedures.</td>
</tr>
<tr>
<td>click, click in</td>
<td>Describes the action of positioning the pointer on a button or icon and then pressing and releasing the mouse button. You <em>click</em> a button or icon. You <em>click in</em> a window or field. You <em>click</em> a link or hyperlink.</td>
</tr>
<tr>
<td>click on</td>
<td>Don’t use; use <em>click</em>.</td>
</tr>
<tr>
<td>close</td>
<td>Dialog boxes <em>open</em> and <em>close</em>, not <em>appear</em> and <em>disappear</em>. Pages <em>appear</em> and <em>disappear</em>.</td>
</tr>
<tr>
<td>collapse</td>
<td>You <em>expand/collapse</em> the branch in the tree hierarchy.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Note uppercase. Always capitalize when referring to Mercury IT Governance Dashboard. Try to avoid using by itself.</td>
</tr>
<tr>
<td>database</td>
<td>Note one word.</td>
</tr>
<tr>
<td>deactivate</td>
<td>Do not use. Use <em>disable</em>.</td>
</tr>
<tr>
<td>deselect</td>
<td>Use when you mean <em>cancel a selection</em>.</td>
</tr>
<tr>
<td>disable</td>
<td>Use this, not <em>turn off</em> or <em>deactivate</em>.</td>
</tr>
<tr>
<td>disappear</td>
<td>Dialog boxes <em>open</em> and <em>close</em>, not <em>appear</em> and <em>disappear</em>. Pages <em>appear</em> and <em>disappear</em>.</td>
</tr>
<tr>
<td>document</td>
<td>Use to refer to the items in the product information set.</td>
</tr>
<tr>
<td>document management module</td>
<td>Functionality produced by EMC/Documentum and provided (at no extra cost) in Mercury IT Governance Center. “Document management module” is preferred over “document management.” For example, “the Mercury document management module allows customers to . . .”</td>
</tr>
<tr>
<td>Documentation home page</td>
<td>• Officially known as Mercury IT Governance Center Documentation home page</td>
</tr>
<tr>
<td></td>
<td>• Note no italics</td>
</tr>
<tr>
<td></td>
<td>• Note capitalization</td>
</tr>
<tr>
<td></td>
<td>• Do not capitalize documentation by itself</td>
</tr>
<tr>
<td>double-click</td>
<td>Note hyphenation.</td>
</tr>
<tr>
<td>download center</td>
<td>Always use “Mercury IT Governance Download Center” (note capitalization).</td>
</tr>
<tr>
<td>drop-down</td>
<td>Hyphenate. For example, drop-down list.</td>
</tr>
</tbody>
</table>
## Table 1-2. Word usage (page 3 of 7)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>download</td>
<td>Verb, noun, and adjective.</td>
</tr>
<tr>
<td>e.g. (not eg. or eg)</td>
<td>Do not use; use <em>for example</em>.</td>
</tr>
<tr>
<td>earlier</td>
<td>Use in a phrase like <em>Oracle 9i or earlier</em>.</td>
</tr>
<tr>
<td>easy, easily</td>
<td>Avoid these words and synonyms for legal reasons (for example, “this new release 6.0 feature allows users to easily run reports . . .”).</td>
</tr>
<tr>
<td>email</td>
<td>Use this, not <em>e-mail</em>.</td>
</tr>
<tr>
<td>enable</td>
<td>Use this, not turn on or activate.</td>
</tr>
</tbody>
</table>
| end user, end-user    | - Noun: end user  
  - Adjective: end-user                                                                                                           |
| ensure                | Avoid this word and synonyms for legal reasons (for example, “this functionality ensures that the Mercury IT Governance Server will . . .”). |
| entity                | Use as a generic term for packages, object types, reports, requests, etc.                                                           |
| etc or etc.           | Do not use. Use *and so forth*.                                                                                                     |
| expand                | You *expand/collapse* the branch in the tree hierarchy. *</p> |
| Extension             | Use uppercase when referring to one of the Mercury Change Management Extensions.                                                     |
| help, online help     | Do not use except to refer to *portlet help* or *general assistance*. Use *HTML document* or *Mercury IT Governance Center Documentation* (the latter if you are referring to the complete documentation set). Italics for emphasis only. |
| higher                | No not use in a phrase like *Oracle 9i or higher*. Use *Oracle 9i or later*, instead.                                               |
| hostname              | One word.                                                                                                                            |
| hyperlink, link       | You *click* a link or hyperlink.                                                                                                     |
| HTML start page       | - The first WebWorks page  
  - Note capitalization  
  - Note no italics                                                                                                                  |
### Table 1-2. Word usage (page 4 of 7)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>icon</td>
<td>- Always use the word icon after the UI item you’re identifying; for example, “Click the Portlet Help icon to view help about the portlet you’re using.” Use the Button/Menu/Tab font style.</td>
</tr>
<tr>
<td></td>
<td>- Example: <strong>Environments</strong> icon (Workbench interface).</td>
</tr>
<tr>
<td></td>
<td>- Do not use this term for a button with text (use <strong>button</strong> instead).</td>
</tr>
<tr>
<td></td>
<td>- Do not include icons in inline text. Use sparingly. If you need to show an icon, put it into an anchored frame.</td>
</tr>
<tr>
<td>i.e. (not ie. or ie)</td>
<td>Do not use; use <strong>that is</strong>.</td>
</tr>
<tr>
<td>immediately</td>
<td>Avoid this word and synonyms for legal reasons (for example, “the window immediately opens”).</td>
</tr>
<tr>
<td>instance</td>
<td>Single installation of an application or database.</td>
</tr>
<tr>
<td>Internet</td>
<td>Capitalize.</td>
</tr>
<tr>
<td>intranet</td>
<td>Do not capitalize.</td>
</tr>
<tr>
<td>ITG</td>
<td>Do not use except for interface labels and objects appearing within Mercury IT Governance Center.</td>
</tr>
<tr>
<td>Key Concepts</td>
<td>Do not include a section of this name (use <strong>Overview</strong>). Point to the <strong>Key Concepts</strong> document as a prerequisite.</td>
</tr>
<tr>
<td>later</td>
<td>Use in a phrase like <strong>Oracle 9i or later</strong>.</td>
</tr>
<tr>
<td>link, hyperlink</td>
<td>You <strong>click</strong> a link or hyperlink.</td>
</tr>
<tr>
<td>log off, logoff</td>
<td>Use this. Two words when a verb. One word when a noun. Do not use variations of log out or sign out.</td>
</tr>
<tr>
<td>log on, logon</td>
<td>Use this. Two words when a verb. One word when a noun. Do not use variations of log in or sign in.</td>
</tr>
<tr>
<td>Library</td>
<td>Do not use; use <strong>Mercury IT Governance Center Documentation</strong>. Italic for emphasis only.</td>
</tr>
<tr>
<td>lower</td>
<td>No not use in a phrase like <strong>Oracle 9i or lower</strong>. Use <strong>Oracle 9i or earlier</strong>, instead.</td>
</tr>
<tr>
<td>Mercury, Mercury Interactive</td>
<td>Use <strong>Mercury Interactive</strong> only at first use (in our books, this is on our copyright page). Thereafter, use <strong>Mercury</strong>.</td>
</tr>
<tr>
<td>Mercury IT Governance Center</td>
<td>Always use this, not <strong>Mercury ITG</strong>.</td>
</tr>
<tr>
<td>Mercury IT Governance Dashboard</td>
<td>Use this. Always capitalize <strong>Dashboard</strong>, even when it is used by itself. Do not include <strong>Center</strong>. You can shorten it to <strong>the Dashboard</strong> (note capitalization).</td>
</tr>
</tbody>
</table>
### Table 1-2. Word usage (page 5 of 7)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mercury IT Governance Center database</td>
<td>Use this. Note the word Center.</td>
</tr>
<tr>
<td>Mercury IT Governance Center Documentation</td>
<td>Use this instead of Mercury IT Governance Center Library.</td>
</tr>
<tr>
<td>Mercury IT Governance Center standard interface</td>
<td>Use this.</td>
</tr>
<tr>
<td>Mercury IT Governance Workbench</td>
<td>Use this. Always capitalize Workbench, even when it is used by itself. Do not include Center. You can shorten it to the Workbench (note capitalization).</td>
</tr>
<tr>
<td>Mercury IT Governance Center Workbench interface</td>
<td>Use this.</td>
</tr>
<tr>
<td>Mercury IT Governance Server</td>
<td>Use this. Do not include the word Center before Server.</td>
</tr>
<tr>
<td>Mercury-supplied entity</td>
<td>Use this, not seeded.</td>
</tr>
<tr>
<td>Migrator</td>
<td>Use uppercase when referring to Mercury Object Migrator or Mercury GL Migrator. Use lowercase when referring to an entity migrator or instance migrator or a migration process in Mercury IT Governance Center.</td>
</tr>
<tr>
<td>MS</td>
<td>Do not use as an abbreviation for Microsoft.</td>
</tr>
<tr>
<td>multithreaded</td>
<td>No hyphen.</td>
</tr>
<tr>
<td>newer</td>
<td>Do not use in a phrase like Oracle 9i or newer. Use Oracle 9i or later, instead.</td>
</tr>
<tr>
<td>older</td>
<td>Do not use in a phrase like Oracle 9i or older. Use Oracle 9i or earlier, instead.</td>
</tr>
<tr>
<td>online help, help</td>
<td>• Do not use. Use HTML document.</td>
</tr>
<tr>
<td></td>
<td>• See also help.</td>
</tr>
<tr>
<td>open</td>
<td>Dialog boxes open and close, not appear and disappear. Pages appear and disappear.</td>
</tr>
<tr>
<td>page</td>
<td>The right-hand panel of the standard interface (but not the Workbench interface). Synonymous with Dashboard page. See also screen and window.</td>
</tr>
<tr>
<td>parent</td>
<td>Used to describe a parent-child relationship. Avoid elsewhere.</td>
</tr>
<tr>
<td>pop-up (noun), pop up (verb)</td>
<td>Use this.</td>
</tr>
<tr>
<td>portlet</td>
<td>Lowercase.</td>
</tr>
</tbody>
</table>
### Table 1-2. Word usage (page 6 of 7)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>prerequisite [document]</td>
<td>Do not use (use related).</td>
</tr>
<tr>
<td>press</td>
<td>You press (not hit) keys on the keyboard.</td>
</tr>
<tr>
<td>preventing</td>
<td>Do not use.</td>
</tr>
<tr>
<td>products</td>
<td>Use as a collective term for the applications, components, etc. that are part of Mercury IT Governance Center.</td>
</tr>
<tr>
<td>right-click</td>
<td>Verb (do not use as a noun).</td>
</tr>
</tbody>
</table>
| roll up, roll-up              | Verb: roll up  
Noun or adjective: roll-up                                           |
| screen, screen group, screen icon | The right-hand panel of the Workbench interface. Each screen is part of a screen group. For example, the Package screen (better to call this the Package Workbench — see below) is part of the Demand Mgmt screen group. A screen icon is a graphic in the menu bar of the Workbench interface. For example, “To open the Packages Workbench, click the Packages screen icon.”
Windows that open on top of a “vanilla” Workbench screen are windows, not pages or screens.
See also page and window. |
| seeded entity                  | Do not use. Use Mercury-supplied entity.                             |
| select                        | You select (not check) a checkbox.                                  |
| server, Server                | Always capitalize in Mercury IT Governance Server (note Server and not Center Server)  
Never capitalize by itself (for example, “to start the server” — referring to the Mercury IT Governance Server)  
Never capitalize when you are referring to Web server or server machine |
| setting, setting up           | Configuring is preferred.                                            |
| simple, simply                | Avoid these words and synonyms for legal reasons (for example, “running reports in release 6.0 is very simple”). |
| subtab                        | A tab below another tab in a navigation hierarchy.  
For example, “in the x tab, click the y subtab.” |
| tablespace                    | Note one word. User table space only when referring directly to an item in the interface that is spelled that way. |
### Table 1-2. Word usage (page 7 of 7)

<table>
<thead>
<tr>
<th>Term</th>
<th>Usage</th>
</tr>
</thead>
</table>
| third party, third-party | • Noun: third party  
• Adjective: third-party  
• Do not use 3rd party or 3rd-party  
• Avoid using; use the name of the specific vendor or supplier, if possible |
| time sheet             | Two words.                                                                                                                            |
| toolbar                | One word.                                                                                                                            |
| turn off               | Do not use. Use disable.                                                                                                               |
| turn on                | Do not use. Use enable.                                                                                                                |
| type                   | Use this, not enter when instructing a user to fill in a field. For example, "type the name of the server into the text box."        |
| user, user ID, user name | Use this. Note capitalization.                                                                                                        |
| using                  | Use only if precisely defined.                                                                                                        |
| window                 | Valid term for both the standard and Workbench interfaces. Windows “float” on top of pages, screens, or other windows.           
When minimized, open windows appear at the bottom of the Workbench screen.  
See also screen and page.                                                                 |
| wizard                 | Do not capitalize. Use when describing the wizards in the product set. Don’t use as a synonym for tool.                                |
| Workbench              | Always capitalize when referring to the Mercury IT Governance Workbench. Don’t overuse the word by itself.                             |
Words Not Capitalized

The following entity names should not be capitalized (this list may not be complete):

- access grant
- action item
- activity
- actual
- application code
- asset
- asset class
- assignment
- auto-complete list
- booking
- budget
- business objective
- business unit
- calendar
- charge code
- command (or special command)
- command step
- communication plan
- contact
- currency
- data mask
- database link
- directory
- distribution
- drop-down list
- entity
- environment, environment group
- exception
- execution log
- field, field group, field logic, field notification, field security
- file
- file system
- filter criteria
- instance
- interface
- issue
- layout
- license
- license key
- log
- menu, menu bar, menu item
- migrator (except for Mercury Object Migrator or Mercury GL Migrator)
- milestone
- module
- multicurrency
- navigation path
- non-workload item
- notification, notification engine, notification template
- object, object type, object type command
- open interface
- organization unit
- override rule
- ownership
• package, package process, package line, package workflow
• page
• parameter
• participant
• password
• patch
• period, period type
• permission
• personalization
• polling
• portfolio
• portlet, portlet help
• product enhancement request
• product screen security
• program
• project
• proposal
• rate
• reference
• release (it’s also release 6.0)
• release manager
• report
• request
• resource
• result
• risk
• run group
• scheduling engine
• scope change
• screen, screen group
• search
• security, security group
• server (for Web server and server (by itself, for Mercury IT Governance Server)
• single sign-on software
• skill, skill rate
• software deployment
• special command, command
• staffing profile
• status dependency
• submenu
• subproject
• subworkflow
• summary condition
• system, system requirements
• table component, table rule
• task
• template
• time
• timeout
• time sheet (two words)
• token, token builder
• transition
• trigger
• upgrade
• user, user account, user access, user data type
• validation
• window
• work allocation, work item
• workflow, workflow engine, workflow parameter, workflow step, workflow step security, workflow step source
• workload item
Indexing Guidelines

Placement

Place index markers at the end of headings, figure titles, and table titles (that is, after the last letter). This is to avoid having cross-reference and index markers stacked at the beginning of the heading.

For individual words or short phrases in paragraphs and notes, place the index marker at the beginning of the word or phrase (with no space between the marker and the first letter of the word).

Consistency of Style

Use a consistent style so entries consolidate properly. This is especially important for the documents appearing in HTML format (whose indexes are merged).

Case

Index entries should be in lowercase unless they are proper nouns.

Use of See and See Also

The words see and see also always appear in italics except when followed by a document title or another word in italics; in those situations, use body font for see and see also. For example, “see request type” and “see also Guide to Documentation.”

If see and see also includes a generic reference (that is, a reference to a type of heading rather than a specific heading), the complete cross reference is italicized. For example, “see also under specific release 6.0 document titles.”

List of Approved Gerunds

Use gerunds, not infinitives or commands, for task entries (for example, use deleting, not delete).

The following gerunds are approved (others may also be acceptable):

- accessing
- adding
- analyzing (demand)
• applying (patches)
• approving
• assigning
• attaching
• automating
• backing up
• booking
• browsing
• cancelling (note spelling)
• changing
• cloning
• closing
• collapsing (menus)
• configuring
• controlling (access)
• converting
• copying
• creating
• customizing
• defining
• deleting
• distributing (modules)
• downloading
• editing
• expanding (menus)
• freezing (time sheets)
• importing
• installing
Chapter 1: Text

- integrating
- logging
- logging off
- logging on
- managing
- merging (patches)
- migrating
- modifying
- moving
- opening
- personalizing
- preparing (for installation or upgrade)
- printing
- processing
- publishing
- releasing (time sheets)
- renaming
- requesting
- reviewing
- running
- scheduling
- searching
- selecting
- setting or setting up (configuring is preferred)
- submitting
- tracking
- updating
- upgrading
Chapter 1: Text

- using (use only if precisely defined)
- validating
- viewing

For More Information

For more detailed guidelines for producing indexes, see Seth Maitlin’s STC presentation described in For More Information on page 30.
For More Information

Referenced and related documents:

- *A Brief, Comprehensive Indexing Primer*, An STC Web Seminar presented by Seth Maislin on October 20, 2004
- *Key Concepts*
- *Oracle Applications Concepts* (Part No. B10642-01), May 2003

Useful for writers working on Oracle-related documents.

Industry-standard style guides:

- *Chicago Manual of Style*, University of Chicago Press, Chicago
Chapter 2

Documentation Artwork

In This Chapter:

- **Overview**
  - Screenshots
  - Graphics
- **Taking Your Screenshots**
  - Capturing the Dashboard
  - Capturing the Workbench
- **Visio Tips and Tricks**
- **Working with Artwork in FrameMaker**
  - Importing Your Artwork
  - Annotating Your Screenshots
  - Verifying the Formatting
Chapter 2: Documentation Artwork

Overview

Within the framework of this discussion, artwork consists of:

- **Screenshots.** These are snapshots of the information displayed on a user’s monitor when using Mercury IT Governance Center.

- **Graphics.** These are diagrams (illustrations) created using Visio. For example, block or process diagrams.

Any other types of visual aids (BMP, WMF, photographs, etc.) will be addressed on a case-by-case basis.

Screenshots

Use the following settings for screenshots:

- Capture using HyperSnap, version 3.0. (An upgrade to version 5.0 is pending.)

- Capture on the Technical Documentation Production Lab system currently located in the cubicle next to Steve.

- Use a resolution of 96 dpi.

- Crop using HyperSnap.

- Resize (scale) using FrameMaker.

- Don’t use a width less than 97 pixels unless for icons, buttons, or similar Windows elements.

- Save as GIF files in the appropriate art folder:

- Use the following maximum dimensions:

  - Width: 5.25 inches (1024 pixels)
  - Height: 8.0 inches (1560 pixels)

Remember that you may want to include annotations that appear outside of the screenshot and this must be considered as part of the overall size. However, this does not affect the capture phase of this process—this impacts the phase when you import the screenshot into FrameMaker.
Chapter 2: Documentation Artwork

Graphics

To create graphics:

- Create (and maintain) using Visio 2002.
- Use a resolution of 96 dpi.
- Use the following maximum dimensions:
  - Width: 5.25 inches (504 pixels)
  - Height: 8.0 inches (768 pixels)
- Make graphics as large as possible while fitting in these dimensions and providing a pleasing design.
- Use the ITG custom colors corresponding to those defined in the FrameMaker color map.

These are the same as detailed in the corporate branding guidelines available on Mindshare with the exception of itg_Crimson_Light, which is specific to our documentation. See Table 2-1 and Figure 2-1 for details.

- Save in the following formats in the appropriate art folder:
  - Visio
  - GIF

Although the following is highly desirable, it may not be entirely feasible for the version 6.0 release.

Note

If you don’t have Visio already installed, Visio can be installed, over the network, from the following shared drive. The license key is available in that same folder.

\eworld\MVPUBLIC-SW-INSTALL\Install_IT\MS_Visio_2002
Table 2-1. Color map

<table>
<thead>
<tr>
<th>Color Name</th>
<th>RGB Value</th>
<th>Visio Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>itg_Crimson</td>
<td>142R/0G/29B</td>
<td>8</td>
</tr>
<tr>
<td>itg_Crimson_Light</td>
<td>145R/0G/0B</td>
<td>9</td>
</tr>
<tr>
<td>itg_Orange</td>
<td>254R/166G/65B</td>
<td>10</td>
</tr>
<tr>
<td>itg_Medium_Gray</td>
<td>145R/143G/144B</td>
<td>11</td>
</tr>
<tr>
<td>itg_Light_Gray</td>
<td>212R/212G/212B</td>
<td>12</td>
</tr>
<tr>
<td>itg_Metallic_Pewter</td>
<td>98R/94G/87B</td>
<td>13</td>
</tr>
<tr>
<td>itg_Gunmetal_Blue</td>
<td>72R/84G/88B</td>
<td>14</td>
</tr>
<tr>
<td>itg_Light_Blue</td>
<td>115R/196G/207B</td>
<td>15</td>
</tr>
</tbody>
</table>

Figure 2-1. Color samples
Taking Your Screenshots

The following information provides the guidelines for capturing your screenshots.

Due to multiple user interface designs within the product, different techniques are used for capturing the various window components of the Dashboard and the Workbench.

Also, do not be concerned about resizing (scaling) since this will be accomplished when importing the screenshots into FrameMaker. This ensures that the artwork reflects the user experience.

Warning
Do not change any of the settings on the Production Lab system.
If you need help or clarification, feel free to contact Steve or Donna.

Capturing the Dashboard

The Dashboard, as well as basic browser pages, can be captured using the following techniques.

Context Screenshots

For screenshots that are to provide context and level-setting:

- Maximize the Dashboard window.
- Do not change the size of any other window.
- In HyperSnap, make sure that:
  - Auto Scroll Window is enabled and used for windows that exceed the vertical size of the screen
  - Include Cursor Image is disabled (unless there is a compelling reason to include the cursor)
- Take the screenshot of the desired area using Capture > Window making sure that the window does not include the browser taskbar.
- Save your screenshot as a GIF file in the appropriate art folder.
Example

Figure 2-2. Dashboard context (width between 715 and 1024 pixels)
Detail Screenshots

For screenshots that are to provide enhanced detail:

- Maximize the Dashboard window.
- Do not change the size of any other window.
- In HyperSnap, make sure that:
  - **Auto Scroll Window** is enabled and used for windows that exceed the vertical size of the screen
  - **Include Cursor Image** is disabled (unless there is a compelling reason to include the cursor)
- Take screen shots using **Capture > Region**.
- Using HyperSnap, crop the image as desired.
- Save your screenshot as a GIF file in the appropriate art folder.

Examples

![Figure 2-3. Dashboard detail (width between 406 and 714 pixels)]
Chapter 2: Documentation Artwork

Figure 2-4. Dashboard detail (width between 497 and 405 pixels)

Figure 2-5. Dashboard detail (width less than 97 pixels)
Capturing the Workbench

The Workbench can be captured using the following techniques.

**Context Screenshots**

For screenshots that are to provide context and level-setting:

- Maximize the window containing the shortcut bar and Workbench window.
- Do not maximize the Workbench window.
- Do not change the size of any other window.
- If necessary, move the Workbench window into the upper-left corner of the blue workspace.
- In HyperSnap, make sure that:
  - **Include Cursor Image** is disabled (unless there is a compelling reason to include the cursor)
- Take the screenshot of the desired area using **Capture > Region**.
- Using HyperSnap, crop the image so that the:
  - Right edge of the Workbench window forms the right boundary
  - Left edge of the shortcut bar forms the left boundary
  - Top edge of the Workbench menu forms the top boundary
  - Bottom of the “meaningful” shortcut bar area forms the bottom boundary
- Save your screenshot as a GIF file in the appropriate art folder.
Chapter 2: Documentation Artwork

Example

Figure 2-6. Workbench context (width between 715 and 1024 pixels)

Detail Screenshots of Workbench Windows

Note

The Workbench window is currently identified by the Mercury Interactive logo.

For screenshots that are to provide enhanced detail:

- Maximize the window containing the menu bar and Workbench.
- Do not maximize the Workbench window.
- Do not change the size of any other window.
- In HyperSnap, make sure that:
  - **Include Cursor Image** is disabled (unless there is a compelling reason to include the cursor)
  - Take the screenshot of the desired area using **Capture > Region**.
  - Using HyperSnap, crop the image as desired.
  - Save your screenshot as a GIF file in the appropriate **art** folder.
For screenshots that are to provide enhanced detail:

- Maximize the window containing the menu bar and Workbench.
- Do not maximize the Workbench window.
- Do not change the size of any other window.
- In HyperSnap, make sure that:
  - Include Cursor Image is disabled (unless there is a compelling reason to include the cursor)
- Take the screenshot of the desired area using Capture > Active Region.
- Using HyperSnap, crop the image as desired.
- Save your screenshot as a GIF file in the appropriate art folder.
Examples

Figure 2-7. Workbench detail (width between 406 and 714 pixels)
Figure 2-8. Workbench detail (width between 97 and 405 pixels)

Figure 2-9. Workbench detail (width smaller than 97 pixels)
Visio Tips and Tricks

A template has been created to help you work with Visio. This template is available from StarTeam at n:\Kintana\Manuals\docs\60PlanningPrototypes\Template\TemplateVisio.vsd.

For your convenience, this template includes color swatches and, incidentally, is the source file for Figure 2-1 on page 34.

To create a new graphic:

1. Either:
   a. Open the template and delete the color swatches.
   Or:

   Set the custom page size to be 5.25 inches by 8.0 inches. (This helps make sure that you design to the available space in the FrameMaker document.)

2. Create your diagram.

3. Add the ITG custom colors:

   - When using the template the ITG custom colors are not readily available from the menu bar. Therefore, you need to:
Chapter 2: Documentation Artwork

c. Select your object.

d. To access the color selector:

- For shapes, use right-click > Format > Fill > Fill Color.
- For text, use right-click > Format Text > Font Color.

e. Click the desired color. The ITG custom colors are identified by color numbers 8 through 15 (as shown in Table 2-1 on page 34 and displayed in Figure 2-1 on page 34).

- Or if you are not using the template:

f. Select your object and create the custom color using the RGB values shown in Table 2-1 on page 34.

4. Once your diagram is complete:

g. Save the diagram as a Visio file in the appropriate art folder.

h. Select all the diagram components using Edit > Select All.

i. Save your diagram as a GIF file in the appropriate art folder.

Set the resolution to 96 dpi by 96 dpi. Also set the size to match that of the diagram (automatically displayed in the Custom text box within the Size field.)

Note

If you are creating multiple diagrams in the same Visio session, you may need to enable the Screen, Printer, or Source radio button in the Size field before selecting the Custom text box. The values displayed there may reflect the dimensions of the previous diagram.
5. Close Visio if you do not want to create any new diagrams.
Working with Artwork in FrameMaker

In general, when importing artwork into FrameMaker, the procedure described in the following section should be followed. However, there are some cases where deviations are expected. These include:

- Importing multiple screenshots into a single anchored frame.
- Including multiple figures within a single task or procedure.
- Importing a screen shot that is to be annotated outside of its boundaries (for example, using call outs).

In the first two circumstances, you should import all the screenshots using the same dpi setting in step d of step 4 on page 48. This will ensure that the relative size of all the screenshots reflects the user experience.

In the last case, you should import the screenshot using the next smaller dpi setting in step d of step 4 on page 48. In rare cases, you may need to further reduce the dpi setting.

Note

It may require some experimentation to determine a suitable dpi setting for all the artwork involved when there are deviations.
Chapter 2: Documentation Artwork

Importing Your Artwork

From your FrameMaker file:

1. Insert an “empty” paragraph tagged as Figure/Table (Before/After) where you would like the artwork to appear.

2. Insert an anchored frame in this paragraph using Special > Anchored Frame > New Frame.

   Set the Anchoring Position to Below Current Line, Alignment to Left, and the Width to 5.25 inches. Do not enable Cropped or Floating. Select the Height of your choice.

3. Select the anchored frame.

4. Include the desired artwork using File > Import > File.

   a. Make sure that Import By Reference is enabled.

   b. Navigate to the desired artwork. (This should be in the document’s corresponding art folder.)

   c. Click OK.
d. From the subsequent Imported Graphic Scaling dialog box, specify the **Custom dpi** using the image width information displayed in that dialog box in conjunction with the following table.

![Note](image)

Remember to allow for any of the deviations discussed in *Importing Your Artwork*.

<table>
<thead>
<tr>
<th>Width (in pixels)</th>
<th>Custom dpi</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Browser</strong></td>
<td></td>
</tr>
<tr>
<td>715 to 1024</td>
<td>195</td>
</tr>
<tr>
<td>406 to 714</td>
<td>162</td>
</tr>
<tr>
<td>97 to 405</td>
<td>129</td>
</tr>
<tr>
<td>1 to 96</td>
<td>96</td>
</tr>
<tr>
<td><strong>Visio Graphic</strong></td>
<td></td>
</tr>
<tr>
<td>1 to 504</td>
<td>96</td>
</tr>
<tr>
<td><strong>Illustrator Graphic</strong></td>
<td></td>
</tr>
<tr>
<td>(from Jeremy or Mandy)</td>
<td></td>
</tr>
<tr>
<td>1 to 788</td>
<td>150</td>
</tr>
</tbody>
</table>

e. Click **Set**

5. If the artwork exceeds the vertical size of the anchored frame, select the anchored frame, then drag the bottom of the frame downwards. Adjust the
Chapter 2: Documentation Artwork

location of the artwork, within the anchored frame, until it fits (in its entirety) within the anchored frame.

6. If the anchored frame includes multiple imported screenshots, remember to select and use one dpi setting for all the imported screenshots. Then:

   f. Arrange the screenshots as desired.

   g. Once all screenshots are imported and arranged, select all the items within the anchored frame and group them using Graphics > Group.

7. If the artwork is to be annotated, review and follow the guidelines described in Annotating Your Screenshots on page 51 before proceeding to the next step.

8. Select the artwork.

   h. View the Object Properties (right-click > Object Properties).

   i. Set the value for both Offset From: Top and Offset From: Left to zero.

   j. Note the values for Unrotated Size: Width and Unrotated Size: Height.

   k. Click Set.

9. Select the anchored frame containing the artwork.

   l. View the Object Properties (right-click > Object Properties).

   m. Set the value for Unrotated Size: Width to that noted in the previous step j.

   n. Set the value for Unrotated Size: Height to one-tenth of an inch more than the value noted in the previous step j.

   o. Click Set.

10. If the artwork appears in a task step, insert an ‘empty’ paragraph tagged as Figure/Table (Before/After) following the paragraph containing the anchored frame.

Note: This step is particularly important for the artwork appearing in the HTML documents.
Otherwise, insert a paragraph with one of the following paragraph tags and title the artwork appropriately:

- FigureTitle
- FigureTitleWide
- FigureTitle (Appendix)
- FigureTitleWide (Appendix)

**Annotating Your Screenshots**

Should you need to annotate the screenshots to highlight details:

- Use:
  - Rounded rectangles to identify common areas.
    - The color for this is black and the size of the line is 3.0 points.
  - If absolutely necessary, identify specific items with call outs.
    - Use black lines having no arrowheads. The line size should be 1.5 points.
    - For text, use the *Call out* character tag.
  - Once all annotations are complete, select all the items within the anchored frame and group them using **Graphics > Group.**
Chapter 2: Documentation Artwork

Verifying the Formatting

A few items require verification before final production of your document. Ensure the following:

- The anchored frame does not extend into the side head of your text area.
- A Figure/Table (Before/After) paragraph precedes each anchored frame and that the paragraph contains only the anchored frame text symbol (an upside-down, uppercase letter T).
- Either:
  - For artwork in a task step, a Figure/Table (Before/After) paragraph follows each anchored frame and that no text (or other text symbols) appears in the paragraph. (The paragraph should be ‘empty.’)
  - A figure title follows the anchored frame and uses one of the following paragraph tags:
    - FigureTitle
    - FigureTitleWide
    - FigureTitle (Appendix)
    - FigureTitleWide (Appendix)
In This Chapter:

- *Product Development Process*
- *Document Authoring Process*
- *Document Review Process*
- *Document Editing Process*
  - Developmental Edits
  - Copy Edits
- *Review/Production Checklist*
Product Development Process

<<Include a high-level view (from the TechPubs perspective) of the product development process.>>
Document Authoring Process

<<Need to include (here or in the text chapter):

- FrameMaker information
- StarTeam information
- FrameMaker file directory structure
- File names
- Graphics directory (named “art”)
- Graphics filenames
- Color guidelines
- Code examples
- Bulleted lists (bullets and hollow bullets)
- Pronoun usage
- Writing procedures
- Writing process overviews>>
Chapter 3: Process

Document Review Process
Document Editing Process

Developmental Edits

Copy Edits
Chapter 3: Process

**Review/Production Checklist**

*Table 3-1* contains the review/production checklist.

**Table 3-1. Review/production checklist (page 1 of 3)**

<table>
<thead>
<tr>
<th>Category, Item</th>
<th>Complete</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General, Text</strong></td>
<td></td>
</tr>
<tr>
<td>Do a spellcheck of the entire book. (You may want to delete the existing dictionary.)</td>
<td></td>
</tr>
<tr>
<td>Update index entries for the entire book, if required.</td>
<td></td>
</tr>
<tr>
<td>Check Chapter 1, Text, on page 5 for the following kinds of issues:</td>
<td></td>
</tr>
<tr>
<td>• Major sections of a document issues (particularly Introduction chapter issues)</td>
<td></td>
</tr>
<tr>
<td>• Style, paragraph and font issues</td>
<td></td>
</tr>
<tr>
<td>• Word usage violations</td>
<td></td>
</tr>
<tr>
<td>• Capitalization violations (especially entity names, which should not be capitalized)</td>
<td></td>
</tr>
<tr>
<td>Search for capitalization inconsistency (for example, search for both Interface and interface).</td>
<td></td>
</tr>
<tr>
<td>Check the index for capitalization problems, consolidation problems, misspellings, etc.</td>
<td></td>
</tr>
<tr>
<td>Remove notes to reviewers (search for &lt;&lt; and &gt;&gt;, AuthNote items, and SMENote items).</td>
<td></td>
</tr>
<tr>
<td>Search for Kintana, Accelerator, Drive, Deliver, 50, 5.0, 55, 5.5, suite, solution, O<em>M, GL</em>M, and other terms obsolete since the prior release(s).</td>
<td></td>
</tr>
<tr>
<td>Change Mercury Interactive to Mercury (except in on the copyright page), ITG to IT Governance, Center Workbench to Workbench, Center Dashboard to Dashboard, Center Server to Server, Release to release, seeded to Mercury-supplied, book to document, template to module, and click on to click.</td>
<td></td>
</tr>
<tr>
<td>Check for correct use of trademarks and registered trademarks. In particular, be sure to add the trademark symbol for first mention of each Mercury IT Governance Center application discussed in the document. &lt;&lt;Steve, do we have a current complete list from Legal?&gt;&gt;</td>
<td></td>
</tr>
<tr>
<td>Check the accuracies of all URLs listed. Also be sure that they are hyperlinked and that the hyperlink works.</td>
<td></td>
</tr>
<tr>
<td>Check the appearance and accuracy of all procedures.</td>
<td></td>
</tr>
<tr>
<td>Check all cross-references (within the document) for relevance.</td>
<td></td>
</tr>
<tr>
<td>Check all references to other documents in the Documentation set. Are the titles accurate? Is the information you’re pointing to really in the document? Are the book titles in italics?</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 3: Process

Table 3-1. Review/production checklist (page 2 of 3)

<table>
<thead>
<tr>
<th>Category, Item</th>
<th>Complete</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Template, FrameMaker</strong></td>
<td></td>
</tr>
<tr>
<td>Did you use the most up-to-date FrameMaker template?</td>
<td></td>
</tr>
<tr>
<td>Remove all deprecated tags.</td>
<td></td>
</tr>
<tr>
<td>Update (run) the entire book in FrameMaker and correct any problems (for example, unresolved cross-references).</td>
<td></td>
</tr>
<tr>
<td>Remove all change bars.</td>
<td></td>
</tr>
<tr>
<td>Check page numbering (title is Roman; TOC, List of Figures, and List of Tables are Roman and continue; chapter 1 is numeric and continues; all other chapters are numeric and continue; Index is numeric and continues).</td>
<td></td>
</tr>
<tr>
<td>Be sure page numbering is <em>not</em> reset to 1 in the Introduction chapter. One reason we use continuous numbering is so the Adobe Reader page number identifier is the same as the number on the actual document page.</td>
<td></td>
</tr>
<tr>
<td>You may need to manually set the first page of the Introduction chapter to get the numbering to be contiguous. You'll also have to monitor this page number throughout the document development process; it may need to be manually reset as TOCs, LOFs, and LOTs expand or contract in size.</td>
<td></td>
</tr>
<tr>
<td>Check headers and footers. (Do not edit-check variables or headers.)</td>
<td></td>
</tr>
<tr>
<td>Check the title page, TOC, List of Figures, List of Tables, part, chapter, appendix, and index files.</td>
<td></td>
</tr>
<tr>
<td>Check the mini-TOC at the beginning of each chapter.</td>
<td></td>
</tr>
<tr>
<td>Page through the entire book (from front to back) and fix widows and orphans.</td>
<td></td>
</tr>
<tr>
<td>Check for table problems, including incorrect titles and incorrect use of Figure/Table (Before/After).</td>
<td></td>
</tr>
<tr>
<td>Be sure all tables have either a &quot;continuation&quot; or &quot;sheet x of y&quot; variable. (See <em>Table 1-1 on page 9</em> for information about when to use which.)</td>
<td></td>
</tr>
<tr>
<td>Check all xrefs (chapters, sections, tables, figures). Be sure use of “on page x” references are used correctly.</td>
<td></td>
</tr>
<tr>
<td>Check for bad word or phrase breaks (especially those containing hyphens) and insert non-breaking spaces or, if necessary, forced line breaks.</td>
<td></td>
</tr>
</tbody>
</table>
Table 3-1. Review/production checklist (page 3 of 3)

<table>
<thead>
<tr>
<th>Category, Item</th>
<th>Complete</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Graphics</strong></td>
<td></td>
</tr>
<tr>
<td>Check the quality of all graphics.</td>
<td></td>
</tr>
<tr>
<td>Review the colors and tags in artwork and callouts.</td>
<td></td>
</tr>
<tr>
<td>Make sure the anchored frames are sized to the artwork.</td>
<td></td>
</tr>
<tr>
<td>Be sure all screenshots were taken in the final 6.0 product.</td>
<td></td>
</tr>
<tr>
<td>Be sure all screenshots show only appropriate data.</td>
<td></td>
</tr>
<tr>
<td><strong>WebWorks</strong></td>
<td></td>
</tr>
<tr>
<td>Mark mini-TOC (and x.Rule paragraphs, x.InThisChapter or x.InThisAppendix) as</td>
<td></td>
</tr>
<tr>
<td>PrintOnly conditional text. Also disable the condition indicator.</td>
<td></td>
</tr>
<tr>
<td>Add a TopicAlias marker (and the text <em>Introduction</em>) before the Introduction</td>
<td></td>
</tr>
<tr>
<td>chapter name.</td>
<td></td>
</tr>
<tr>
<td>Search for red Courier text and fix FrameMaker style problems showing up in WebWorks</td>
<td></td>
</tr>
<tr>
<td>Correct any WebWorks production problems.</td>
<td></td>
</tr>
<tr>
<td><strong>Final Production</strong></td>
<td></td>
</tr>
<tr>
<td>Be sure all the graphics (in GIF format) are in the art directory. Delete all</td>
<td></td>
</tr>
<tr>
<td>graphics no longer used.</td>
<td></td>
</tr>
<tr>
<td>Check the final files (book and art) into StarTeam with an appropriate label (</td>
<td></td>
</tr>
<tr>
<td>entered as a comment) — for example, “final 6.0 version.”</td>
<td></td>
</tr>
</tbody>
</table>
In This Chapter:

- Prerequisites
  - Requirements
  - Highly Desired
  - Requested
- Getting Your Document Into a Build
- Assessing the Evaluation Site Results
  - For the HTML Version of Your Document
  - For the PDF Version of Your Document
- Assessing the Product Results
Chapter 4: Release 6.0 Production Procedure for Authors

Prerequisites

As you produce drafts and especially prior to final document production, evaluate your documents to ensure that what you expect is being created by the production tools and processes.

There are a number of assessments and actions that should be completed prior to any checkin (either for evaluation purposes or of a final document).

Requirements

- StarTeam folder contains only the book file and the FrameMaker files included in the book.
- None of the aforementioned files are locked.
- Remove all FrameMaker backup files from StarTeam.
- There are no unresolved cross-references in your book.
- There is no unresolved artwork. (Placeholders are OK until early January.)
- Notification to Donna of any changes in book structure. For example, renaming, removing, adding, or reorganizing a FrameMaker file within the book.
- All deprecated styles have been removed.
- TopicAlias marker has been added to first chapter (usually Introduction). (Applies to all documents even those not deployed as HTML.)
- The mini-TOCs are conditionalized as PrintOnly. (Applies to all documents even those not deployed as HTML.)
Chapter 4: Release 6.0 Production Procedure for Authors

Highly Desired

- All review/production checklist items, listed in the *Documentation Style and Process Guide*, have been completed.
- Document is at current template release level.
- Art folder contains only the artwork used in the document.

**Note**
After early January, these become requirements.

Requested

- Notification of the status of screenshots and graphics. For example, all screenshots are final and there is one more graphic to be completed and incorporated.
Getting Your Document Into a Build

To get your updated document into the next build of the Evaluation site and/or staged for the next product build, notify Donna via email that the files are ready to be updated. Please include the StarTeam path to the document.

Once Donna receives your email:

- The files will be locked as soon as possible.
- The files will be copied to the Production Staging site in preparation for updating the builds.
- The files will be unlocked and you will be notified that the files have been released for your use.

Between now and early January, indicate if the book should be updated on the Evaluation Site only.

Assessing the Evaluation Site Results

Watch for the announcement from Donna that the Evaluation Site has been updated. If the logfile from AutoPDF has been included with the message, review that and remove any un-necessary cross-references from your documents.

Then carefully review your document as described in the following sections. If you have any questions or concerns, ask Donna for assistance.

For the HTML Version of Your Document

- Make sure that the document opens to the first page of the Introduction chapter. If this does not work, check that the TopicAlias marker is correctly set in your FrameMaker file.
- Confirm that the document does not open in a new window.
- Verify that the Contents frame expands and highlights the title of your document. If this does not work, check that the TopicAlias marker is correctly set in your FrameMaker file.
Chapter 4: Release 6.0 Production Procedure for Authors

- Make sure that the document, including chapters, appendices, cross-references, hyperlinks, table of contents (Contents tab), and index (Index tab) correspond to your intent and expectations.

- Confirm that there are no mini-TOCs at the beginning of each chapter. If any mini-TOCs exist, conditionalize them to PrintOnly in your FrameMaker file and remember to deselect Show Condition indicators.

- Text shown in red typeface indicates that there is a template style violation. Review your FrameMaker file and make sure that these are corrected.

There is one known problem with the WebWorks translation from FrameMaker into HTML.

- The first table (other than Note or Warning) in any chapter will have its first text shown in red.

- For BasicA tables, this red text appears in the title. For BasicB tables, the red text appears in the first table cell.

- If your first table in a chapter does not have any red text, that may also indicate a problem. This is usually attributed to the use of a table format that is not in the template.

There is a workaround for this matter and it will be implemented during the final production run.

- Once all problems are corrected, re-submit the document for production.

For the PDF Version of Your Document

- Make sure that the document, including cross-references, hyperlinks, table of contents, and index correspond to your intent and expectations.

- Verify that the document opens, in Adobe Reader, to the title page.

- Confirm that the document does not open in a new window.

- Ensure that the Documentation Home Page link (in the bookmarks) returns you to the Documentation Home Page.

- Make sure that the mini-TOCs appear and are not in green or red text.
Assessing the Product Results

Monitor the Smoke instance of the N2 testing sites.

Once the Smoke instance has been updated with the most recent build, review the document there. Make sure that this version of the document is as expected. If not, contact Donna.

When time permits, review the documentation using Internet Explorer (version 6.0 or later).
To import data from an Excel spreadsheet into FrameMaker:

1. Open the Excel file.
2. Using Save As, save the file as a Text (tab delimited) (*.txt) file.
4. Open the newly created text file using Notepad.
5. Select all the text.
6. Copy the text (to the Windows clipboard).
7. Close the text file.
8. Open your FrameMaker file.
9. Position your cursor where you want the data (table) to appear.

Note: You may want to insert some placeholder empty paragraphs around this location.
10. Paste the data (from the Windows clipboard).

11. Select all the spreadsheet data.

12. Using **Table > Convert to Table**, convert the data back into a table that mimics the Excel spreadsheet.

Some things to consider about the conversion:

- **Table Format.** Do you want a title for the table? If yes, select Basic A. If not, use Basic B.

- **Table Header.**
  - Do you want to include a header for the table and is the information for the header included in your data? If yes, use the settings shown in *Figure A-1*.

  ![Figure A-1](image)

  *Figure A-1. Include a header with existing data*

  - Do you want to include a header for the table and you do not have the information in your spreadsheet data? If yes, use the settings shown in *Figure A-2*.
Figure A-2. Include a header and add new heading information

- If you do not want any header, use the settings shown in Figure A-3.

Figure A-3. Do not include a header

13. Verify that the data mimics your Excel spreadsheet.

14. Remove any blank paragraphs that you may have inserted to help bracket the imported data.

15. Save your FrameMaker file.


17. Delete the intermediate text file (optional).
Index

A
About This Document section 6
access grant 21
accessing 26
acronym 9
action item 21
activate 14
active voice 9
activity 21
actual 21
adding 26
address (Web) 9
Adobe Reader 14
analyzing 26
appear 14
appendixes 7
application 14
application code 21
approving 27
artwork, producing using FrameMaker 47
as is 14
as-is 14
asset 21
asset class 21
assigning 27
assignment 21
attaching 27
authoring process 55
auto-complete 14
auto-complete list 21
automating 27
auto-populate 14

B
backing up 27
bash 14
before 14
book 14
booking 21, 27
Bourne shell 14
browsing 27
budget 21
bullet 9
business objective 21
business unit 21
button 9
Index

C
calendar 21
callout 9
canceling 14
cancelling 14, 27
capitalization 10
Caution 14
Caution box 10
changing 27
chapters
  introduction 6
  other 7
charge code 21
check 14
check in 14
check out 14
checkbox 14
check-in 14
checklist, production and review 58
check-out 14
child 15
choose 15
click 15
click in 15
click on 15
cloning 27
close 15
closing 27
codeline 15
code examples 55
collapse 15
collapsing 27
color guidelines 55
color map 34
command 21, 24
command step 21
communication plan 21
configuring 27
contact 21
continuation variable 10
controlling 27
converting 27
copying 27
copyright page 6
Courier 10
creating 27
currency 21
customizing 27

D
Dashboard 15
data mask 21
database 15, 18
database link 21
deactivate 15
defining 27
Definition box 10
deleting 27
deselect 15
directory 21
disable 15
disappear 15
distributing 27
distribution 21
document 15
  major sections of 6
document authoring process 55
document management module 15
document review process 56
Documentation home page 15
double-click 15
download 16
download center 15
downloading 27
drop-down 15
drop-down list 21
E
e.g. 16
earlier 16
easily 16
easy 16
editing 27
email 16
em-dash 10
enable 16
end user 16
en-dash 10
end-user 16
ensure 16
entity 16, 22
environment 22
environment group 22
etc 16
Example box 10
Excel spreadsheet 67
exception 22
execution log 22
expand 16
expanding 27
Extension 16

F
field 22
field group 22
field logic 22
field notification 22
field security 22
figure label 10
figure title 10
file 22
file system 22
filter criteria 22
For More Information section 6
FrameMaker 55
freezing 27

G
gerunds, list of approved 26
graphics directory 55
graphics, producing 33

H
help 16, 18
higher 16
hostname 16
HTML start page 16
hyperlink 16, 17
HyperSnap 32
hyphen 11
hyphenation 11

I
i.e. 17
icon 11, 17
immediately 17
importing 27
index 7
indexing guidelines 26
installing 27
instance 17, 22
integrating 28
interface 22
Internet 17
intranet 17
introduction chapter 6
issue 22
italic 11
ITG 17

K
Key Concepts 11, 17
Key Concepts 11
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>L</strong></td>
</tr>
<tr>
<td>later</td>
</tr>
<tr>
<td>layout</td>
</tr>
<tr>
<td>Library</td>
</tr>
<tr>
<td>license</td>
</tr>
<tr>
<td>license key</td>
</tr>
<tr>
<td>line breaks</td>
</tr>
<tr>
<td>link</td>
</tr>
<tr>
<td>list of figures</td>
</tr>
<tr>
<td>list of tables</td>
</tr>
<tr>
<td>log</td>
</tr>
<tr>
<td>log off</td>
</tr>
<tr>
<td>log on</td>
</tr>
<tr>
<td>logging</td>
</tr>
<tr>
<td>logging off</td>
</tr>
<tr>
<td>logging on</td>
</tr>
<tr>
<td>logoff</td>
</tr>
<tr>
<td>logon</td>
</tr>
<tr>
<td>lower</td>
</tr>
</tbody>
</table>

| **M** |
| managing | 28 |
| menu | 22 |
| menu bar | 22 |
| menu item | 22 |
| Mercury | 17 |
| Mercury Interactive | 17 |
| Mercury IT Governance Center | 17 |
| Mercury IT Governance Center database | 18 |
| Mercury IT Governance Center Documentation | 18 |
| Mercury IT Governance Center standard interface | 18 |
| Mercury IT Governance Center Workbench interface | 18 |
| Mercury IT Governance Dashboard | 17 |
| Mercury IT Governance Server | 18 |
| Mercury IT Governance Workbench | 18 |
| Mercury Support | 11 |
| Mercury-supplied entity | 18 |
| migrating | 28 |
| Migrator | 18 |
| migrator | 22 |
| milestone | 22 |
| modifying | 28 |
| module | 22 |
| moving | 28 |
| MS | 18 |
| multicurrency | 22 |
| multithreaded | 18 |

| **N** |
| navigation path | 22 |
| navigational sequence | 11 |
| newer | 18 |
| non-workload item | 22 |
| Note box | 11 |
| note to reviewers | 11 |
| notification | 22 |
| notification engine | 22 |
| notification template | 22 |
| numerals | 12 |

| **O** |
| object | 22 |
| object type | 22 |
| object type command | 22 |
| older | 18 |
| online help | 16, 18 |
| open | 18 |
| open interface | 22 |
| opening | 28 |
| organization unit | 22 |
| orphans and widows | 13 |
| override rule | 22 |
| Overview section | 6 |
ownership 22

P
package 23
package line 23
package process 23
package workflow 23
page 18, 23
page breaks 13
parameter 23
parent 18
participant 23
password 23
patch 23
period 23
period type 23
permission 23
personalization 23
personalizing 28
polling 23
pop up 18
pop-up 18
portfolio 23
portlet 18, 23
portlet help 23
prerequisite 19
Prerequisite Documents section 6
press 19
preventing 19
printing 28
process
  document authoring 55
  document review 56
  product development 54
processing 28
product 19
product development process 54
product enhancement request 23
product screen security 23
production checklist 58
Production Lab (Technical Documentation) 32
program 23
project 23
proposal 23
publishing 28
punctuation 12

Q
quotation marks 12

R
rate 23
reference 23
Related Documents section 6
release 23
release manager 23
Release Notes 8
releasing 28
renaming 28
report 23
request 23
requesting 28
resource 23
result 23
review checklist 58
reviewing 28
right-click 19
risk 23
roll up 19
roll-up 19
run group 23
running 28

S
scheduling 28
scheduling engine 23
Index

scope change 24
screen 19, 24
screen group 19, 24
screen icon 19
screenshots, producing 32, 35
search 24
searching 28
sections
  About This Document 6
  For More Information 6
  Overview 6
  Prerequisite Documents 6
  Related Documents 6
  Who Should Read This Document 6
security 24
security group 24
seeded entity 19
select 19
selecting 28
Server 18
server 19, 24
setting 19, 28
setting up 19, 28
sheet x of y table continuation variable 12
signs and symbols 12
simple 19
simply 19
single sign-on software 24
single-chapter documents 8
skill 24
skill rate 24
software deployment 24
special command 21, 24
spreadsheet, Excel 67
staffing profile 24
standard interface 18
StarTeam 55
status dependency 24
submenu 24
submitting 28
subproject 24
subtab 19
subworkflow 24
summary condition 24
system 24
system requirements 24
T
table component 24
table of contents 6
table rule 24
table title 12
task 24
Technical Documentation Production Lab 32
template 24
time 24
time sheet 20, 24
timeout 24
Tip box 12
title page 6
token 24
token builder 24
toolbar 20
tracking 28
trademark 13
transition 24
trigger 24
turn off 20
turn on 20
type, vs. enter 20

U
updating 28
upgrade 24
upgrading 28
user 20, 24
user access 24
Index

user account 24
user data type 24
user ID 20
user name 20
using 20, 29

V
validating 29
validation 25
viewing 29
Visio 33

W
Warning box 13
we (the “royal we”) 13
Web 20
Web address 9
Web server 20
WebWorks 16
white papers 8
Who Should Read This Document section 6
widows and orphans 13
window 20, 25
wizard 20
word wraps 13
work allocation 25
work item 25
Workbench 18, 20
Workbench interface 18
workflow 25
workflow engine 25
workflow parameter 25
workflow step 25
workflow step security 25
workflow step source 25
workload item 25